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What is WebDesign?
WebDesign is the professional web authoring package for Mac OS X. By focusing on 
the tools web developers need, WebDesign lets you create beautiful, standards based, 
error free websites. 

WebDesign's focus is on providing the tools you need to design, code, and upload your 
website. Its got an entire collection of HTML Tools to help make sure your code is 
standard based, error free, and online as quickly as possible. WebDesign includes built 
in support for HTML, XHTML, Cascading Style Sheets, PHP, Javascript, ASP and more. 

With dozens of FREE add-ons and enhancements, the WebDesign Community offers 
additional tools to make sure you get your websites finished in less time. 

Where to Get Support
There are many ways to get additional support for WebDesign if you still have questions 
after reading through this user manual.

The RAGE Discussion forum at http://www.ragesw.com/forums/ connects you with other 
RAGE users who can help answer questions or provide helpful advice. There are also 
many helpful posts that may already contain answers to your questions.

You can also contact RAGE Software directly through our support form. The following 
url takes you to our support pages which contain a knowledge base and an online form 
to send us your questions and comments. We love hearing from our users so please 
feel free to contact us with any questions you may have.

Online Support: http://www.ragesw.com/support/

Twitter: http://www.twitter.com/ragesw

Facebook: http://www.facebook.com/ragesoftware

http://www.ragesw.com/forums/
http://www.ragesw.com/forums/
http://www.ragesw.com/support/
http://www.ragesw.com/support/
http://www.twitter.com/ragesw
http://www.twitter.com/ragesw
http://www.facebook.com/ragesoftware
http://www.facebook.com/ragesoftware


What Is HTML & HTML Basics
Before using WebDesign it is important that you have a brief understanding of HTML 
and know the basics of writing HTML code.

HTML (Hypertext Markup Language) is the language used to create and design web 
pages. HTML files are simply text documents containing instructions telling the web 
browser how to format your web page. An HTML document contains HTML tags which 
are in the form of:

<TAGNAME ATTRIBUTE="VALUE">

Basically the TAGNAME is an instruction for your web browser on what to do. There is a 
list of TAGNAME's which can be found at HTMLHelp.com. This list also contains 
instructions on what these tags do. As you can see from the example above, tags can 
have attributes. Attributes are additional information given to your web browser to read 
and display the HTML document properly. For example, the <img> (image) tag requires 
a 'src' attribute that points to the image on your server that your browser should display.

Tags are not limited to just one attribute. They can have many attributes which give web 
browsers additional information. Some attributes are required, such as the 'src' attribute 
for image tags while other attributes, such as the 'height' and 'width' attributes for image 
tags are not required, but recommended.

In some cases an HTML tag may need an ending tag which are simply written as:

</TAGNAME>

For example, to tell your browser to make some text bold you would write;

<B>...bold text...</B>.

The most basic web page can be written as follows;

<HTML>

! <HEAD>

! <TITLE>Web Page Title</TITLE>

! </HEAD>

! <BODY>

...anything that should be displayed in the browser window goes here...

! </BODY>

</HTML>



Any text that is written between the <BODY> and </BODY> tags will show up on your 
website unless it is incased in (<>). HTML is not case sensitive so <BODY> and <body> 
are seen as the same instructions to a web browser. Some users find it easier to read 
HTML pages when the tags are written in uppercase, however it is now a common 
practice to keep all tags in lowercase to maintain compatibility with different kinds of 
devices.

Fortunately, WebDesign allows you to convert tags to lowercase or uppercase simply by 
going to HTML Tools->Change Tag Case.

Line Breaks In HTML Pages

As noted above, all text placed with the <BODY> and </BODY> tags, excluding text 
incased in (<>), will show up in your web browser. This, however, is not entirely true 
when working with line breaks. Line Breaks are ignored by browsers and this can 
usually cause confusion for first time web developers.

There are two ways to insert line breaks in your document.

You can use the <BR> tag which will create a single line break.

These lines of text appear on
<BR> different lines in your browser

or the;

<P>...</P>

Tag to create a new paragraph which will insert two line breaks around the surrounded 
text.

(note: </P> is not required when creating a paragraph, but is highly recommended. It is 
a good idea to get into the habit of closing all tags that have a required or optional 
closing tag including <P>, <LI> etc... To learn why, read the section on XHTML in this 
user manual).

Linking to Other Pages

If you would like users to be able to access another website, or another page on your 
site, you can use a hyper link to accomplish this. To create a hyperlink either use the 
drag and drop tools palette to your left or use the Insert menu and select 'Link...'.

Type the address that you would like the link to take the user to in the URL field. Type 
the text that should be displayed in the browser in the 'Text' field. Click the 'Insert' button 
and the text will be inserted into your document.



(Note: You can leave the Target field blank. This attribute is usually used with frames or 
to control whether or not the link is opened in a new window. You can press the Help 
button to learn more about it but in this example you can ignore it.)

Notice the code that is entered;

<a href="http://www.ragesw.com">Rage Software</a>

As you can see the <a> tag is used to create a link to another website and the 'href' 
attribute is used to specify the location of the website. The text to be displayed in the 
browser is between the <a> and </a> tags. It is a good idea to study the code that is 
generated by WebDesign's wizards so that you are able to more quickly become 
familiar with the different tags and attributes in the HTML language.

Online Resources

The following links are all available for free online and will give you more insight into 
HTML and how to develop and expand your HTML knowledge; 
HTML, XHTML and CSS hands on tutorial 
http://www.w3.org 
http://www.HTMLHelp.com 
http://www.w3schools.com

http://www.ragesw.com
http://www.ragesw.com
http://www.w3.org
http://www.w3.org
http://www.HTMLHelp.com
http://www.HTMLHelp.com
http://www.w3schools.com
http://www.w3schools.com


Quick Start: Your First Website
WebDesign makes it extremely easy to create new websites using the built in 
templates. It offers both ready made templates to base your website on, or a set of 
blank page layouts. When you first launch WebDesign, you will see the new website 
window below.

You can either select one of the pre-made templates, open an existing website or create 
a new webpage using the Web Page wizard.

Scroll through the available templates which range from fully developed websites to 
blank templates. Once you have chosen a template, press the ʻSelectʼ button.



WebDesignʼs Site Manager will open along with the Site Settings window. From this 
window you can select a predefined FTP account to publish your website to. At this time 
you can ignore this option if you do not yet have a web host set up. However, once you 
select your FTP server, WebDesignʼs Site Manager provides one-click publishing of all 
modified files to your web server.

Your purchase of WebDesign gets you up to 4 months of free web hosting and a free 
domain name with RAGE Web Hosting so you can get your website up and running today. 
Try RAGE Web Hosting risk free with our 30 day money back guarantee.

http://www.ragesw.com/webhosting.php
http://www.ragesw.com/webhosting.php
http://www.ragesw.com/webhosting.pph
http://www.ragesw.com/webhosting.pph


Once you have entered your website settings, all of your website files will be listed for 
you in the Site Manager. The index.html file is the default page that will load when 
someone enters your domain name into their web browser. The rest of the pages are 
sub pages linked from the navigation menu of each page.

The Site Manager provides everything you need to manage your website in WebDesign. 
You can add new files by pressing the plus (+) button underneath the file listing. If you 
are using a template, the new pages will be based on your existing template file.

For now, we will double click our index.html to open it up in WebDesignʼs editor.



As you can see below, WebDesign provides a text editor and a visual preview of your 
website which gets updated as you edit your page.

If you have used Appleʼs Pages software you may notice the similarities between the 
two applications. WebDesign provides a sub toolbar at the top of the window that 
provides common tasks like changing fonts, font size, styles, colors, as well as inserting 
lists tables, links and images. 

Just like any word processing application, WebDesign lets you select a block of text and 
easily apply style changes such as making the text bold, italic or underlined. Just select 
a block of text and press the B button in the sub toolbar (or press Command-B). 
Likewise, many of the other styling options can be applied in a similar manner.

In addition to what is provided in the sub toolbar, WebDesign also provides over 40 built 
in wizards which can be inserted into your webpage from the Tools window on the left 
hand side of your screen or the Insert menu in your menubar at the top of your screen.



With WebDesign you can quickly and easily drag and drop HTML wizards from the 
Tools window into your document. Since only content placed within the <body> and </
body> tags will be rendered in your browser, all wizards should be placed within these 
tags.

Editing Features
WebDesign makes it extremely easy to work with your HTML webpage files. All of your 
HTML tags are color coded so you can easily separate HTML markup with regular text 
content. Syntax coloring also allows you to easily spot basic coding errors in your 
HTML.

WebDesign also includes auto completion of HTML tags, attributes and attribute values. 
As you type, a list of all available HTML tags and attributes will be provided.



Pressing the tab key on your keyboard will insert the currently selected autocomplete 
tag. You will also notice that WebDesign provides HTML attribute suggestions and 
attribute value suggestions including a built in color picker to easily insert web safe 
colors into your document.

Lastly, WebDesign also includes an easy to use attribute editor. Open the attribute 
editor by clicking the Attributes button in the toolbar. Now, when you click within an 
HTML Tag, the attributes editor will list all the attributes for the selected HTML tag to 
easily edit them. If an attribute requires a specific value, you can select it from the 
predefined list. 



Easy Editing With WebDesignʼs Sub Toolbar
Most of your HTML needs can be handled by WebDesignʼs sub toolbar, directly above 
WebDesignʼs text editor. We will go through each option so you can see what each 
toolbar item can do.

1. The CSS Style Menu provides access to all style sheet Class and ID definitions 
attached to the current HTML document, whether internal or external. You can select 
a block of text, and then select one of the style sheets from this menu to apply the 
style rules to the currently selected text.

2. The Font menu provides access to commonly used web safe fonts. You can apply 
the selected fonts to the currently selected text.

3. The Size menu lets you change the size of the selected text. Size is determined 
using emʼs, which is a standard way to specify font size on the web. Emʼs are a 
relative measure, where 1.0em will keep the font at its current, default size. 2.0em will 
make the font double the size, while .5em will cut the font size in half.

4. The Color button will let you specify the text color of the currently selected text.

5. The Style menu will let you change the style of the currently selected text. You can 
give it emphasis, make it a subscript or superscript, strikethrough or pre formatted 
text. 

6. The bold, italic and underline buttons will apply those options to the currently 
selected text.

7. The Alignment menu lets you easily align text left, right, centered or justified.

8. The Header menu lets you mark selected text as header text, ranging from header 1 
to header 6. Header 1 is the most important heading, all the way down to header 6.

9. The List menu will either insert a new list with the chosen options or convert normal 
text to a list if a block if text is currently selected.

10. The Link menu will let you quickly insert a link into your webpage. It also provides 
access to all documents in your website that is currently opened in your Site Manager 
so you can quickly link to any other page in your site.

11. The Image menu lets you quickly insert an image into your webpage. Like the Link 
menu it also provides easy access to all images in your website.

1. 2. 3. 4. 5. 6. 7. 8. 9. 10. 11. 12.



12. The Table menu provides a quick table builder so you can easily insert a table with 
up to 7 columns and 5 rows.

Working With Different Documents Types
WebDesign makes it very easy to work with different kinds of documents including 
HTML files, CSS files, PHP files, Javascript and more. WebDesign lets you customize 
its editor to work better with the supported document types using the Document Modes 
feature.

In the top right corner of the document window you will see the Document Modes menu 
that lets you switch between 
document modes. WebDesign 
will automatically recognize 
what document mode should be 
used for different types of files, 
however, when working with 
files containing many different 
types of code, you may find it 
convenient to be able to quickly 
switch between document 
modes.



To edit the settings for Document Modes select ʻEdit Document Modes...ʼ from this 
menu. The Preferences window will open as shown below, allowing you to modify how 
each document mode behaves, and what file extensions are recognized and assigned 
to a document mode.

• File Extensions: Set the file extensions, separated by a semicolon (;), that should be 
opened under the selected Document Mode. For example, HTML files are recognized 
by files with the extensions html, shtml, htm and shtml in the picture above.

• Default Extension: The default extension is the extension that an unsaved document 
will use when using the selected document when you save a file. In this picture above 
no default extension is used but you can type .html for all files saved under the HTML 
Document Mode. The default extension only applies to the Save As dialog box and no 
file extension is appended when opening and existing document. Note: In Mac OS X, 
if a default extension is specified, it cannot be changed in the Save As dialog. This is 
the way Apple designed the Save As dialogs in Mac OS X and is why the default 
extension for all document modes is not set.



• Syntax File: Lets you select the syntax file or add a new one to your Syntax Files 
Folder located in the Support Folder in the same folder as the WebDesign Application. 
Creating Syntax files is very easy and is discussed more in the technotes section of 
the User Manual. When you add new syntax files they are moved to your Syntax Files 
folder.

• Wrap Text: Enable or disable soft wrapped text. Soft wrapped text can be wrapped at 
the end of the window or at a certain pixel length. The different between soft wrapped 
and hard wrapped text is with soft wrapped text the text is wrapped to a new line when 
it hits a certain spot (the end of the window or the specified pixel length) while hard 
wrapped text only wraps when you create a new line break.

• Enable Tabs: If you want to be able to use tabs as well as specify the tab width, 
enable this option.

• Auto Indent: This option, when checked, will start new lines containing the same 
amount of tabs and spaces as the line above it up to the first real character. For 
example if the current line is tabbed 3 spaces over, the next line, after pressing return, 
will start at 3 tabs over. This is helpful in keeping readable code while preventing you 
from having to type those extra keystrokes each time.

• Smart Indenting Braces: This option, depicted above with the PHP function example, 
will auto indent text when the current line contains a '{' character and detab when you 
close the function by entering the '}' character.

• Use XML Syntax Rules: This option will adhere to XML syntax rules, such as entering 
text in lower case, not leaving out quotes etc... It is used specifically for the XHTML 
and XML Document Modes.

• Auto Complete HTML Tags: As you type, WebDesign can autocomplete HTML tags, 
tag attributes and attribute values for you.

• Auto Complete Site Files: When editing an attribute value that references a web 
page or image file, WebDesign can auto-complete the file paths for you. This only 
works if a site is currently opened in the Site Manager.

• Auto Complete End Tags: If this option is selected, tags will automatically be closed, 
if they require a closing tag, as you type your HTML code.

• Show Line Numbers: This option shows the line numbers in your document along the 
left hand side so you can easily see which line you are typing in.

• Match Opening Parenthesis: WebDesign can highlight an opening parenthesis or 
flash the menu bar if it can't find an opening parenthesis so you can easily spot a 
missing parenthesis in your code.



The above options can be modified for the current document only by using the Settings 
button in the toolbar. Any changes you make here will only be applied to the front most 
document.



Website Management

Local Website Management with the Site Manager
WebDesign makes it extremely easy to manage your websites locally on your computer 
with the built in Site Manager. 

You can easily import any website made in any other web building software, including 
iWeb, RapidWeaver, Dreamweaver, Freeway, Frontpage and more, no matter what 
operating system you used. 

To import a website, go the File menu and select New Website Project... to display the 
Templates window. Click the Open... button and select Import Local Folder. 
WebDesign will allow you to select a local website folder on your computer.

Once you import your website or select one based on a template, the entire website will 
be opened in WebDesignʼs Site Manager.



The Site Manager lets you easily create new pages for your site, remove pages, edit 
page in WebDesign as well as publish your entire website to your web server.

WebDesignʼs Site Manager contains a very powerful Prepare Site button that lets you 
apply various code changes, optimizations, and validity checking on your entire site.

Before publishing your website to your server, you should use the Prepare Site features 
to check for broken links on your site and HTML syntax errors.



As can be seen in the Prepare Website window, you get a detailed list of any problems 
with your website. Clicking on any of the errors or warnings will open the selected 
document and bring you to the location in your source code where the problem can be 
found. 

The Prepare Website button also lets you apply certain code changes such as 
converting your website to CSS or XHTML, optimizing your HTML so it loads faster in 
your web browser, as well as beautifying your HTML code so it makes it easier to edit 
documents.

The Filter field lets you control which document types are affected. In this example we 
only want HTML documents to be checked processed so we enter all the file extensions 
of HTML pages, separated by semicolons (;).

Publishing a Website to Your Web Server
When you are done editing your website, you can publish your it to any web server. If 
you have previously published your website, only pages that have been modified since 
your last publish will be uploaded.

To publish your website click the Publish button. If you have not yet entered an FTP 
server, WebDesignʼs Site Settings window will open so you can select one. Once 
selected, all of your modified website files will be published.



Remote Website Publishing
WebDesign also includes a built in FTP Client so if you prefer to edit your web page 
documents right from your server you can easily do this.

To access the FTP Client, go to the Window menu and select FTP Client.... 

The FTP Client provides all the standard features of a regular FTP application. You can 
create New Folders, New Files, edit file permissions, delete files or folders and even 
edit files simply by double clicking them.

When you double click a file it will be downloaded and Opened in WebDesign for 
editing. Once you have edited your document in WebDesign your file will be republished 
to your server when you save it.



WebDesign Include Files
When working on a website you will come across many situations where multiple pages 
will include the exact same code. Instead of making you duplicate your code over and 
over again, WebDesign allows you to include files within your document so that all 
similar text can come from one file on your site. This will not only allow for less code to 
maintain, but it also allows one file to be edited which will affect every page in your 
website. By using WebDesign Includes you can easily keep your document smaller 
while editing, update your entire website by modifying one document as well reduce the 
amount of time it takes to fix problems with your website.

WebDesign includes are entered within HTML comments. This will prevent the include 
statements from having any affect on the way your web page is displayed in a web 
browser.

Including files in your page
To include a file within your document you simply use the following syntax;

<!-- wd_include file="filename"--> <!-- /wd_include file="filename"-->

You can also include a document by going to the 'Insert' menu and selecting 
'WebDesign Include...'. A select file dialog will appear allowing you to select a document 
that you would like to include in your web page. WebDesign will automatically generate 
the appropriate include syntax for you.

Include statements are case sensitive and must be typed exactly as shown above. The 
file name is also case sensitive. Any text written in between the include statements will 
not be included in the saved file and won't show up in a web browser.

How WebDesign finds included files
If your document has been previously saved, WebDesign will look for a folder named 
'Includes' within the same directory as the saved file. If no folder is found, WebDesign 
will make its way up the hierarchy looking for a folder named 'Includes'. If it still cannot 
locate the 'Includes' folder or the appropriate included file, It will look in the 'Includes' 
folder contained in the same folder as the WebDesign application.

If your document has not been saved, WebDesign will simply look for the included file 
within the 'Includes' folder contained in the same folder as the WebDesign application.

WebDesign includes are for local use only. You do not need to upload the includes 
folder to your FTP sever.

Updating included files
When you update a file that is included in another document, all documents that include 
that file must be updated as well. Fortunately WebDesign can automate this process for 
you.



You can update the included files in a single file, a folder or an entire site from within 
WebDesign. You can either select 'Update Includes' from the 'Insert' menu or use the 
Site Manager's Update Includes toolbar button.

When to use WebDesign Includes
Of course WebDesign includes can be used anywhere you like, there are some 
situations where using includes can be a great help to website development. The 
following are great examples of where includes can be very beneficial;

• The header or footer of a web page

• Including scripts such as javascript, PHP etc...

• Copyright info

• Navigation buttons

• Logos or images that you want to update constantly

• A link back to your home page

• Pages created within other editors



Storing Commonly Used Code As Snippets
If you have a set of commonly used code that you like to use over multiple documents 
such as a special script that you like to use, or a navigation bar, WebDesign allows you 
to store such code as a snippet which can be accessed whenever you need to use it 
without having to copy and paste from multiple documents or rewrite code over and 
over again.

To store a snippet, open the Snippets window from under the Window menu. The 
Snippet window, shown below, allows you to create a new Snippet by pressing the '+' 
button. You can give it a name then enter the text in the text field that you would like the 
snippet to enter when you press the 'Insert' button or double click the snippet from the 
left list.

WebDesign's Snippets window also supports drag and drop. You can drag text from 
WebDesign's editor and drop it into the Snippets window to create a new snippet of that 
text. Notice the 'New With Selection' tool bar button which will create a new snippet 
based on the selected text in your document.

WebDesign also contains a handy 'Save As Snippet' 
contextual menu which appears whenever you select some 
text and right click in WebDesign's editor.



Setting up and using Markers
If you need a way to quickly jump to certain parts of a document, such as functions, 
scripts, links, headers or anything else for that matter, WebDesign's markers feature lets 
you do this with ease. Lets say for example you are creating a page with dozens of 
different headings. To create the headings you are simply using the HTML Header tags 
(<H#> and </H#>) to make the headers stand out on your website. As your page gets 
longer and longer, jumping between headers gets very tedious. You can always use the 
Find feature but this can get overwhelming and time consuming. Instead, using the 
Markers features would make much more sense and be much quicker.

To set up the Markers feature, Open the Preferences window and select the Markers 
tab or select Add Marker from the Marker button's menu (third button at the top of each 
document window) to go directly to this tab. Fortunately, for this task an example is 
already there for you. Select the example labeled Headers, click the add button and 
save your preferences. Now all your headers are listed in the Marker button's menu. 
You can select one to quickly jump to the correct location in your document. You will 
notice that this marker works for any size header from H1 all the way to H5. This is 
because it uses WebDesign's powerful pattern searching (called regular expression) to 
search your document.



Set up Function Markers by entering the start string and the end string that WebDesign 
should search for in your document. When it finds these strings, the text in between 
them are listed in the Function Markers menu in each document window. You can even 
define regular expression search strings

An example may not always be available so setting up markers may not always be this 
easy, but it does not get much harder. To set so up a custom marker, enter the start and 
end strings that WebDesign should look for. WebDesign will search your entire 
document for each occurrence of these strings and, if found, the text that they surround 
will be listed in the marker button's menu and is where WebDesign will jump to when the 
marker is selected. For example, if you enter 'href="' in the start string field and '"' into 
the end string field, any text that follows 'href="' all the way till the next '"' will be listed in 
the marker button's menu and will be highlighted when the marker is selected. 

WebDesign also provides options to help narrow your search. You can set it to be case 
sensitive so that it does not match 'A' if your enter 'a' and you can also set it to only 
match entire words. The third option allows you to enable regular expressions for your 
search terms. This allows you to enter complex patterns instead of simple strings for 
WebDesign to search for. Regular expression syntax is explained in more detail in 
Section 6 'Search & Replace' of this user manual. Lastly you can also set the document 
mode that the search pattern should be applied to. For example, if your marker was set 
to find HTML headers you might only want it to be enabled for HTML documents or if 
your marker was set to find PHP functions you may only want it to be enabled for PHP 
documents. This can help speed up WebDesign's searching and remove unwanted 
markers from the menu.



Language Extensions
With many different syntax rules and keywords in the multitude of web languages, it is 
difficult to remember the proper rules for coding. WebDesign's Language Extensions 
remove the need to memorize the specific syntax and proper format of the supported 
languages. Language Extensions provides a list of the entire or most commonly used 
syntax for a specific language and allows you to automatically insert the code into your 
document.

To open the Language 
Extensions window go to 
Window menu and select 
Language Extensions. The 
Language Extensions window 
provides a menu at the top of 
the window with the supported 
languages. Selecting a 
language will list the keywords/
code available. To enter the 
code into your document, either 
double click one of the items in 
the list or drag and drop an item 
into your document.

In this example we see a list of 
almost all CSS 2 definitions. 
We can double click any of 
them to add one to our front 
most document. We can also 
click one of the help icons to 
load a help resource describing 
what each item does.



More Web Developer Tools
Are you looking to drive more traffic to your website or add professional graphics or 
designs? Look no further, RAGE Software offers search engine optimization software, 
easy to use graphics applications, and beautifully designed website templates. All free 
downloads for you to try only at: http://www.ragesw.com/products.php

RAGE Web Hosting: Web hosting from the Mac company you trust!
Get reliable web hosting from the Mac software company you trust. RAGE Software 
now offers affordable web hosting to all Mac users in addition to the high quality web 
developer software tools.

http://www.ragesw.com/webhosting.php

RAGE SERank
Keep track of your website rankings in over 100 search engines. Learn who is 
outranking you and stealing your potential customers. Track your search engine 
ranking, and those of your competitors, over time with powerful graphing features, and 
even compare rankings of multiple keywords at once.

http://www.ragesw.com/products/search-engine-rank.html

RAGE Domainer
Manage your websites with RAGE Domainer. RAGE Domainer lets you keep track of 
the domains you own, and the domains you want to own letting you know when they 
expire and which ones provide the best bang for your buck by displaying key popularity 
statistics. 

http://www.ragesw.com/products/domainer.html

RAGE SEKeyword
Research and brainstorm the most popular keywords that will drive traffic to your 
website. RAGE SEKeyword is a free application from RAGE Software that makes it 
easy to discover popular keywords that your customers are searching for in all major 
search engines.

http://www.ragesw.com/products/domainer.html

http://www.ragesw.com/products.php
http://www.ragesw.com/products.php
http://www.ragesw.com/webhosting.php
http://www.ragesw.com/webhosting.php
http://www.ragesw.com/products/search-engine-rank.html
http://www.ragesw.com/products/search-engine-rank.html
http://www.ragesw.com/products/domainer.html
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RAGE Sitemap Automator
XML Sitemaps provide search engines with unique information about each page on your 
website allowing it to get indexed faster and achieve higher rankings in search engines. 
Now works with Yahoo, Ask and MSN!

http://www.ragesw.com/products/googlesitemap.html

RAGE WebCrusher
Optimize your websites so they load as quickly as possible for your website visitors. 
Most visitors will wait no longer than 8 seconds for your website to fully load, with 
WebCrusher you can reduce their weight time dramatically

http://www.ragesw.com/products/webcrusher.html

RAGE ButtonDesign
Impress your website visitors with professional looking CSS and HTML buttons with 
mouse down and mouse over transitions. Finish it off by adding your unique touch to 
match the look and feel of your website.

http://www.ragesw.com/products/buttondesign.html

RAGE MapDesign
Add a little interactivity for your website visitors without slow loading multimedia. RAGE 
MapDesign makes it extremely easy to impress your website visitors with fast loading, 
standards based, interactive Image Maps.

http://www.ragesw.com/products/mapdesign.html

Custom Designed Templates
Get professionally designed, beautiful HTML and css templates ready for you to use for 
your website. RAGE Website Templates are royalty free, search engine ready, and 
optimized for use with RAGE WebDesign.

http://www.ragesw.com/templates.php
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